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Introduction

The ATSAMR30M Sensor Board (DT100130) is a hardware platform used to evaluate the performance of the
ATSAMR30M18A (Sub-1 GHz IEEE® 802.15.4™ compliant) RF module. The sensor board provides easy access to
various ready-to-use applications supported by the ATSAMR30M18A module in the Atmel Studio Integrated
Development Platform (IDP). This document describes how to get started with the sensor board and how to integrate
the module in a custom design. The sensor board provides 802.15.4 wireless functionality to the mikroBUS™

compatible Clicker Board evaluation platform in the 800/900 MHz ISM band.

Features

• ATSAMR30M18A Module is an IEEE 802.15.4 Compliant Wireless Module for 700/800/900 MHz(1) Applications
– ATSAMR30E18A (ARM® Cortex® -M0+) System-in-a-Package (SiP)
– Single-ended RF output through the PCB castellated pad
– Radio module with a link budget

• RX sensitivity up to -105(2) dBm
• TX output power up to 8.7(2) dBm

– High precision 16 MHz crystal oscillator
• On-board PCB Antenna
• On-board AT30TSE758A Digital Temperature Sensor

– Integrated temperature sensor, non-volatile registers and serial EEPROM
– 2-wire I2C and SMBus compatible serial interface

• Footprint Provision for Evaluating CryptoAuthentication™ Device (ATECC608A/ATECC508A)
• Power Supply Options

– Battery holder for a standard 3V CR2450 coin/button cell battery
– Header (J5) for external supply
– Clicker receptacle (J1) for supply from a Click board

• Serial Wire Debug (SWD) Header
• Digital I/O

– Clicker receptacles comprising SPI, I2C and UART interfaces of ATSAMR30M18A
– One RESET button and one user button
– One user LED

• Supports Performance Analyzer Example Application in Atmel Studio
• Operating Temperature Range: -40°C to +85°C

Notes: 
1. The PCB antenna supports only the 868-928 MHz band.
2. When fRF = 868.3 MHz, BPSK-20.
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1. Quick References

1.1 Reference Documentation
For further study, refer to the following:

• ATSAMR30M Sensor Board Product Page
• ATSAMR30M Sensor Board Design Documentation Package containing Schematics, BOM, Assembly drawings,

3D plots, PCB Layer plots and so on
• SAMR30 Module Xplained Pro User's Guide
• SAMR30 IEEE® 802.15.4™ Sub-1GHz Module Datasheet
• IEEE 802.15.4 Sub-GHz System-in-Package Datasheet
• AT86RF212B Low Power, 700/800/900MHz Transceiver for ZigBee, IEEE 802.15.4, 6LoWPAN, and ISM

Applications Data Sheet
• 9- to 12-bit Selectable, ±0.5°C Accurate Digital Temperature Sensor with Nonvolatile Registers and Serial

EEPROM Datasheet
• CryptoAuthentication™ Device Summary Datasheet

1.2 Software Prerequisites
• Atmel Studio 7.0
• Wireless Composer 7.0

1.3 Hardware Prerequisites
• ATSAMR30M Sensor Board Evaluation Kit
• Atmel-ICE basic kit (ATATMEL-ICE-BASIC)
• USB to UART converter or mikroBUS FTDI Click Board

 ATSAMR30M
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2. Kit Overview
The ATSAMR30M Sensor Board is a hardware platform used to evaluate the ATSAMR30M18A module in the
mikroBUS compatible Clicker evaluation platform. This evaluation kit supports the Standalone mode, using a CR2450
battery or an external supply.
Figure 2-1. ATSAMR30M Sensor Board

External Supply Header (J5)

LDO Selection/Bypass Jumper (J4)

PCB Antenna

SWD Programming Header (J3)

Reset Button

User Button

Clicker Header (J1)

Clicker Header (J2)
Temperature Sensor

Crypto Device

LDO

ATSAMR30M18A Module
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3. Hardware Specifications
This chapter describes the hardware features and a range of peripheral components of the ATSAMR30M Sensor
Board.

3.1 Battery Holder
A 3V coin cell battery can be used to power-up the board using the battery holder (BT1) in the Standalone mode (for
example, battery powered wireless sensor node). The positive terminal of the holder is marked with a ‘+’ symbol on
top of it.

3.2 LED
The red color user LED (D1) is available on the board. The ATSAMR30M18A module can control this LED by driving
the connected I/O line to GND to activate the LED. There is no power indication LED available on the board.

Table 3-1. LED Functions

Pin on ATSAMR30M Pin Function

PA27 Red LED (D1) control

3.3 Mechanical Buttons
The ATSAMR30M Sensor Board contains two mechanical buttons:

• Reset button (RS_BTN) connected to the ATSAMR30M Reset line
– When the RS_BTN button is pressed, the Reset line is driven to ground, which resets the module

• Generic user-configurable button (USR_BTN)
– When the USR_BTN button is pressed, the I/O line is driven to ground

Note:  The PA28 pin connected with USR_BTN can be used as a wake-up source from the Backup mode of the
ATSAMR30M Sensor Board.

Table 3-2. Mechanical Button Functions

Pin on ATSAMR30M Signal Name Pin Function

RESET RST_BTN Reset switch

PA28 USR_BTN User switch

3.4 Temperature Sensor
The ATSAMR30M Sensor Board has an on-board digital temperature sensor (AT30TSE758A). This sensor is
interfaced with the ATSAMR30M through I2C bus and is available on I2C slave address 0x48 (7-bit MSb address).
The AT30TSE758A also has a serial EEPROM, which is accessible through the same I2C bus with the slave address
as 0x50 (7-bit MSb address).

Table 3-3. Temperature Sensor Functions

Pin on ATSAMR30M Pin Function Shared Functionality

PA08 I2C Serial Data (I2C SDA) ATECC608A and J2 pin 6

PA09 I2C Serial Clock (I2C SCL) ATECC608A and J2 pin 5

 ATSAMR30M
Hardware Specifications
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...........continued
Pin on ATSAMR30M Pin Function Shared Functionality

PA07 Alert J2 pin 2

3.5 CryptoAuthentication Device
The ATSAMR30M Sensor Board has a footprint provision for evaluating the Microchip ATECC608A
CryptoAuthentication IC. The following table lists the interfaces between the CryptoAuthentication IC and the
ATSAMR30M.

Table 3-4. CryptoAuthentication Device Functions

Pin on ATSAMR30M Pin Function Shared Functionalty

PA08 I2C Serial Data (I2C SDA) Temperature sensor and J2 pin 6

PA09 I2C Serial Clock (I2C SCL) Temperature sensor and J2 pin 5

3.6 Headers and Receptacles
The following headers and receptacles are supported by the ATSAMR30M Sensor Board.

3.6.1 mikroBUS Compatible Clicker Receptacles
The mikroBUS Clicker Board is an evaluation platform that provides an easy extension to many applications. This
platform consists of a series of Click Boards that are easily pluggable with the ATSAMR30M Sensor Clicker Board.
The mikroBUS Click Boards support a wide range of different applications. These Click Boards are connected
through a set of standardized headers and receptacles. All mikroBUS Clicker Boards contain two single row, 8-pin,
100-mil receptacles. The Clicker Boards have female connectors, while Click Boards have their male counterparts.

Note:  All pins are not always connected. The Clicker receptacles can be used to connect a variety of Click Boards
or to access the pins of the target MCU on the Clicker Board directly.

The mikroBUS Clicker Board receptacles (J1 and J2) provide the interface to use the ATSAMR30M Sensor Board.
The following tables provide the pin details of these receptacles, respectively.

Table 3-5. Receptacle (J1) Pin Details

Pin on J1 Pin Function Pin on ATSAMR30M Description

1 MB_AN PA06 AIN[6]; ADC pin

2 MB_RST PA15 GPIO; can be used to reset the connected Click
Board

3 MB_CS PA17 SERCOM1/PAD[1]; slave select for SPI

4 MB_SCK PA19 SERCOM1/PAD[3]; clock for SPI

5 MB_MISO PA16 SERCOM1/PAD[0]; MISO line of SPI

6 MB_MOSI PA18 SERCOM1/PAD[2]; MOSI line of SPI

 ATSAMR30M
Hardware Specifications
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...........continued
Pin on J1 Pin Function Pin on ATSAMR30M Description

7 VCC_3V3 VCC 3.3V power supply
• To power the connected Click Boards when

the ATSAMR30M Sensor Board is supplied
by battery or external supply in the LDO
Selection mode.

• To power the ATSAMR30M Sensor Board
from a connected Click Board like the FTDI
Click Board, which has its own power
source.

8 GND GND Ground

Table 3-6. Receptacle (J2) Pin Details

Pin on J2 Pin
Function

Pin on ATSAMR30M Description Shared
Functionality

1 MB_PWM PA14 PWM output —

2 MB_INT PA07 Hardware input interrupt —

3 MB_RX PA25 SERCOM3 PAD[3]; UART RX of the
ATSAMR30M

—

4 MB_TX PA24 SERCOM3 PAD[2]; UART TX of the
ATSAMR30M

—

5 MB_SCL PA09 SERCOM0/PAD[1]; I2C Serial Clock
Line (SCL) for the bus clock

Temperature sensor
and ATECC608A

6 MB_SDA PA08 SERCOM0/PAD[0]; I2C Serial Data
Line (SDA) for data transfer

Temperature sensor
and ATECC608A

7 NC — Not connected —

8 GND GND Ground —

3.6.2 Serial Wire Debug Header
The SWD header (J3) is on-board for programming and debugging the ATSAMR30M18A module. The pinout of this
header is compatible to interface with the SAM port of Atmel-ICE or SAM-ICE using the ATATMEL-ICE-ADPT
accessory kit. The following table lists the pin details of the SWD header.

Table 3-7. SWD Header

Pin Number Pin Name

1 VCC

2 SWDIO

3 GND

4 SWDCLK

5 GND

6 NC

 ATSAMR30M
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...........continued
Pin Number Pin Name

7 NC

8 NC

9 GND

10 RESET

3.6.3 LDO Selection/Bypass Header
The ATSAMR30M Sensor Board operates with supply voltage ranging from 1.8V(1) to 3.63V. Low Dropout Regulator
(LDO) selection/bypass header (J4) is used to select/bypass the LDO based on the need for 3.3V supply.

Jumper positions for the following modes of power supply:
• LDO Bypass mode(2) – Place the jumper cap between pins (1 and 2) of J4
• LDO Selection mode(3) – Place the jumper caps between pins (1 and 3) and pins (2 and 4) of J4 as shown in 

Figure 2-1.

Notes: 
1. If the CryptoAuthentication™ device (ATECC608A) is mounted on the board, the minimum supply voltage

required to operate it is 2V.
2. LDO Bypass mode can be used to avoid LDO current consumption for extending the battery life. This is the

preferred mode if the ATSAMR30M Sensor Board is supplied with a 3V battery or 3.3V from a Click Board
(FTDI Click Board).

3. LDO Selection mode can be used if the ATSAMR30M Sensor Board supplies power to the connected Click
Board, which needs 3.3V to operate.

3.6.4 External Supply Header
The standard bench power supply provides power to the external supply header (J5), to evaluate the operating
voltage range (1.8V – 3.6V). LDO Bypass mode must be used to test the supply voltage range.

Note:  With no power multiplexer on-board, connect either a battery or an external supply or an FTDI Click Board to
power up the ATSAMR30M Sensor Board.

 ATSAMR30M
Hardware Specifications
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4. Getting Started
This chapter provides the prerequisites to start the evaluation with the ATSAMR30M Sensor Board. The sensor board
is factory programmed with the Performance Analyzer application firmware. Users with a new board from the factory
must follow instructions given in Section 4.1  Setup for Standalone Operation and Section 4.2.2  Programming
Wireless Assembly Using Atmel Studio 7.0 (skip Step 7 and 8) for setup. Refer to Section 4.2.1  Installing Wireless
Composer 7.0 Extension in Atmel Studio 7.0 to install the wireless composer and to get started with Performance
Analyzer GUI.

4.1 Setup for Standalone Operation
The ATSAMR30M Sensor Board supports the Standalone mode with an external programmer/debugger (Atmel-ICE
or SAM-ICE™) and a UART-USB converter (like FTDI Cable) interfaced to UART pins of J2 for evaluation. To supply
power, connect the board with either a 3V coin cell battery or a 3.3V through J5 header (external supply).

The setup shown in the following figure consists of a jumper configuration for the LDO Selection mode. To power the
module across the operating voltage range of 1.8V to 3.63V, the jumpers must be in LDO Bypass mode.

Note:  Refer to Section 3.6.3  LDO Selection/Bypass Header for more details.

Figure 4-1. Sensor Board Setup with External Programmer/Debugger, UART-USB Converter and External
Supply

4.1.1 ATSAMR30M Sensor Board and mikroBUS Click Board Interface
The receptacles (J1 and J2) provide the interface to use the ATSAMR30M Sensor Board with a Click Board. The
connection of the sensor board with an FTDI Click Board is shown in the following figure. Similarly, the sensor board

 ATSAMR30M
Getting Started
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can also be connected with a Click Board that has different functionality to demonstrate applications based on
customer requirements.

The ATSAMR30M sensor board interfaced with the FTDI Click Board could be used as an alternate to the setup
shown in Figure 4-1. The FTDI Click Board could power the ATSAMR30M sensor board and act as the UART-USB
Converter. This setup can only be operated at 3.3V as the FTDI Click Board is the power source.

Figure 4-2. ATSAMR30M Sensor Board and mikroBus FTDI Click Board Connection

mikroBUS FTDI Click Board ATSAMR30M Sensor Board

4.2 Performance Analyzer
The Performance Analyzer firmware with a GUI (Wireless Composer Extension) in Atmel Studio provides a way to
perform a number of basic RF functional tests. A quick-start guide and general help are available in the starting page
of the Performance Analyzer window of the Atmel Studio. The latest version of Atmel Studio is 7.0.

This section guides the user to install the necessary wireless extension and to program the wireless assembly using
Atmel Studio 7.0.

4.2.1 Installing Wireless Composer 7.0 Extension in Atmel Studio 7.0
The following steps explain how to install the necessary wireless extension tool in Atmel Studio 7.0.

1. Install and open Atmel Studio.
2. Go to the Tools menu and click Extensions and Updates....

 ATSAMR30M
Getting Started
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Figure 4-3. Extensions and Updates Menu Option

3. In the Extensions and Updates window, click Available Downloads.
4. Expand All options on the left navigation pane and click Wireless.
5. Select Wireless Composer 7.0 and click Download, which directs to Microchip Gallery.

Figure 4-4. Extensions and Updates Window

6. Log in to the Microchip Gallery with a myMicrochip account.

 ATSAMR30M
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Figure 4-5. Microchip Gallery Dashboard

7. Search for Wireless Composer in the search bar and click the latest version.
Figure 4-6. Wireless Composer Page

8. On the webpage of the extension, click Download and, when prompted for file download, click Open. The
extension automatically installs after completion of the download.

9. Install Wireless Composer.

 ATSAMR30M
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Figure 4-7. VSIX Installer

10. Restart Atmel Studio after the installation. The Performance Analyzer GUI will be available in the Tools menu.
Figure 4-8. Performance Analyzer Menu Option

4.2.2 Programming Wireless Assembly Using Atmel Studio 7.0
The following steps explain how to program the ATSAMR30M Sensor Board and get started with the Performance
Analyzer application.

1. Power up the board with a battery or external supply and connect a generic USB-UART converter to the UART
pins of the sensor board. Otherwise, use an FTDI Click Board(1) for powering up(2) and enabling UART
communication with the Sensor Board.
Notes: 
1. The resistors (J1, J2, J3) mounted in the position indicated by I2C need to be removed and

assembled in the UART position as shown in the following figure.
2. Do not use the FTDI Click Board for the UART connection if the sensor board is powered from an

external supply voltage other than 3.3V. When required to evaluate at voltage levels other than 3.3V,
use the setup described in Figure 4-1.

 ATSAMR30M
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Figure 4-9. Resistor Jumpers' Placement for FTDI Click Board in UART Mode

2. Open Atmel Studio.
3. Navigate to the menu File > New > Example Project.
4. Select SAMR30 from the Device Family drop-down list.
5. Enter Performance analyzer in the "Search for Example Projects" field. Select "Performance Analyzer

Application AT86RF212B - SAM R30 Module Xplained Pro" to create an example project under the selected
directory.
Figure 4-10. Selecting Performance Analyzer Application

6. After the project solution is successfully opened, initiate the build by clicking 'Build solution' from the Build
menu.

7. Connect an external debugger, like Atmel-ICE, to the ATSAMR30M Sensor Board. Ensure that the pin 1 of the
cable (indicated by red wire) is interfaced to the SWD header, as shown in the following figure.

 ATSAMR30M
Getting Started
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Figure 4-11. Connecting Programmer/Debugger with ATSAMR30M Sensor Board

8. After successful build completion, open the Device Programming window from the Tools menu.
9. In the Device Programming window, set the following:

– Tool – Atmel-ICE
– Device – ATSAMR30E18A
– Interface – SWD

10. Click Read to read the device signature and target voltage. If there are issues in reading the signature or
target voltage, ensure that the programming cable is firmly connected to the SWD header.

11. Navigate to the Memories tab and click Program.

 ATSAMR30M
Getting Started
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Figure 4-12. Device Programming

12. Open the Performance Analyzer from the Tools menu in Atmel Studio.
13. Follow the Quick Start guidelines available in the starting page of the Performance Analyzer window.
14. Select COM port of the UART-USB converter and click Connect. The Performance Analyzer connects with the

ATSAMR30M Sensor Board. When using the FTDI Click Board as a UART-USB converter, the FTDI Click
Board enumerates as Two COM ports. Use the port with lower COM number for interfacing with the
Performance analyzer GUI.

 ATSAMR30M
Getting Started
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Note:  The Performance Analyzer allows setting or changing of the parameters like Channel Page, Channel, TX
Power Register Value and so on, to perform various RF tests. For more details about the use of the Performance
Analyzer, click the help icon as shown in the following figure.
Figure 4-13. Performance Analyzer - Help

 ATSAMR30M
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5. Regulatory Approval
This equipment (ATSAMR30M Sensor Board/DT100130) is an evaluation kit and not a finished product. It is intended
for laboratory evaluation purposes only. It is not directly marketed or sold to the general public through retail; it is only
sold through authorized distributors or through Microchip. Using this requires engineering expertise towards
understanding of the tools and relevant technology, which can be expected only from a person who is professionally
trained in the technology.

When this module is used in USA/Canada, the user must restrict the operating frequency band within 902-928 MHz.
For Europe, the user must ensure that the module is operated only within the 868-868.6 MHz frequency band.
Regulatory compliance settings have to follow the ATSAMR30M18A module certifications.

The following regulatory notices are to cover the requirements under the regulatory approval.

5.1 United States
The ATSAMR30M Sensor Board (DT100130) contains the ATSAMR30M18A module, which has received Federal
Communications Commission (FCC) CFR47 Telecommunications, Part 15 Subpart C “Intentional Radiators” single-
modular approval in accordance with Part 15.212 Modular Transmitter approval.

Contains Transmitter Module FCC ID: 2ADHKR30M

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Important:  FCC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for uncontrolled environment. The
antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm
from all persons and must not be co-located or operating in conjunction with any other antenna or
transmitter. This transmitter is restricted for use with the specific antenna(s) tested in this application for
certification.

CAUTION
Any changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate this equipment.

FCC Notice
This kit is designed to allow:

• Product developers to evaluate electronic components, circuitry or software associated with the kit to determine
whether to incorporate such items in a finished product.

• Software developers to write software applications for use with the end product. This kit is not a finished product
and when assembled may not be resold or otherwise marketed unless all required FCC equipment
authorizations are first obtained. Operation is subject to the condition that this product not cause harmful
interference to licensed radio stations and that this product accept harmful interference. Unless the assembled
kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate
under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this
chapter.

• The kit is for evaluation only; not FCC approved for resale; and any radio frequency transmitter employed as
part of an evaluation kit shall be designed to comply with all applicable FCC technical rules, including frequency
use, spurious and out-of-band emission limits and maximum power or field strength ratings applicable to final
products that would employ the components or circuitry to be evaluated.

 ATSAMR30M
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• Under 47 CFR 2.805(d)(2), in order to operate the evaluation kit, the user must ultimately render the device
inoperable or return it to Microchip.

• Evaluation kit is defined by FCC as “[a]n assembly of components, subassemblies, or circuitry, including
software, created by or for a component maker, system integrator, or product developer for the sole purpose of
facilitating: End product developer evaluation of all or some of such components, subassemblies, or circuitry, or
(ii) the development of software to be used in an end product.” (see 47 CFR 2.1)

5.2 Canada
The ATSAMR30M Sensor Board (DT100130) contains the ATSAMR30M18A module, which has been certified for
use in Canada under Innovation, Science and Economic Development Canada (ISED, formerly Industry Canada)
Radio Standards Procedure (RSP) RSP-100, Radio Standards Specification (RSS) RSS-Gen and RSS-247.

Contains IC: 20266-R30M

This device contains license-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and Economic
Development Canada’s license-exempt RSS(s). Operation is subject to the following two conditions:

1. This device may not cause interference;
2. This device must accept any interference, including interference that may cause undesired operation of the

device.

L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR d’Innovation,
Sciences et Développement économique Canada applicables aux appareils radio exempts de licence. L’exploitation
est autorisée aux deux conditions suivantes:

1. L’appareil ne doit pas produire de brouillage;
2. L’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en

compromettre le fonctionnement.

WARNING This equipment complies with radio frequency exposure limits set forth by Innovation, Science and
Economic Development Canada for an uncontrolled environment. This equipment must be installed and
operated with a minimum distance of 20 cm between the device and the user or bystanders.

Cet équipement est conforme aux limites d'exposition aux radiofréquences définies par d’Innovation,
Sciences et Développement économique Canada pour un environnement non contrôlé. Cet équipement
doit être installé et utilisé avec un minimum de 20cm de distance entre le dispositif et l'utilisateur ou des
tiers.

The following table provides the specification of the integrated PCB antenna on the ATSAMR30M Sensor Board.

Table 5-1. PCB Antenna Specifications

Parameter Value

Peak gain 0.44 dBi

Operating frequency 868- 928 MHz

5.3 Europe
This equipment (DT100130) has been assessed under the Radio Equipment Directive (RED) for use in European
Union countries. The product does not exceed the specified power ratings, antenna specifications and/or installation
requirements as specified in the user manual. A Declaration of Conformity is issued for each of these standards and
kept on file as described in RED.

Simplified EU Declaration of Conformity

 ATSAMR30M
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Hereby, Microchip Technology Inc. declares that the radio equipment type [DT100130] is in compliance with Directive
2014/53/EU.

The full text of the EU declaration of conformity is available at (refer product specific pages): www.microchip.com/
design-centers/wireless-connectivity/.

 ATSAMR30M
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The Microchip Website

Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner and under normal

conditions.
• There are dishonest and possibly illegal methods being used in attempts to breach the code protection features

of the Microchip devices. We believe that these methods require using the Microchip products in a manner
outside the operating specifications contained in Microchip’s Data Sheets. Attempts to breach these code
protection features, most likely, cannot be accomplished without violating Microchip’s intellectual property rights.

• Microchip is willing to work with any customer who is concerned about the integrity of its code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code

protection does not mean that we are guaranteeing the product is “unbreakable.” Code protection is constantly
evolving. We at Microchip are committed to continuously improving the code protection features of our products.
Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act.
If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue
for relief under that Act.
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Legal Notice

Information contained in this publication is provided for the sole purpose of designing with and using Microchip
products. Information regarding device applications and the like is provided only for your convenience and may be
superseded by updates. It is your responsibility to ensure that your application meets with your specifications.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL OR
CONSEQUENTIAL LOSS, DAMAGE, COST OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or
expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, HELDO, IGLOO, JukeBlox,
KeeLoq, Kleer, LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PackeTime, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon,
TempTrackr, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, FlashTec, Hyper Speed Control,
HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider,
Vite, WinPath, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BlueSky, BodyCom,
CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM,
dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial Programming, ICSP,
INICnet, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, memBrain, Mindi, MiWi, MPASM, MPF,
MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, SAM-ICE, Serial Quad
I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher II, Total Endurance, TSHARC, USBCheck, VariSense,
ViewSpan, WiperLock, Wireless DNA, and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A.
and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2020, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

ISBN: 978-1-5224-6454-9
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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AMERICAS ASIA/PACIFIC ASIA/PACIFIC EUROPE
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support:
www.microchip.com/support
Web Address:
www.microchip.com
Atlanta
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455
Austin, TX
Tel: 512-257-3370
Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago
Itasca, IL
Tel: 630-285-0071
Fax: 630-285-0075
Dallas
Addison, TX
Tel: 972-818-7423
Fax: 972-818-2924
Detroit
Novi, MI
Tel: 248-848-4000
Houston, TX
Tel: 281-894-5983
Indianapolis
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380
Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800
Raleigh, NC
Tel: 919-844-7510
New York, NY
Tel: 631-435-6000
San Jose, CA
Tel: 408-735-9110
Tel: 408-436-4270
Canada - Toronto
Tel: 905-695-1980
Fax: 905-695-2078

Australia - Sydney
Tel: 61-2-9868-6733
China - Beijing
Tel: 86-10-8569-7000
China - Chengdu
Tel: 86-28-8665-5511
China - Chongqing
Tel: 86-23-8980-9588
China - Dongguan
Tel: 86-769-8702-9880
China - Guangzhou
Tel: 86-20-8755-8029
China - Hangzhou
Tel: 86-571-8792-8115
China - Hong Kong SAR
Tel: 852-2943-5100
China - Nanjing
Tel: 86-25-8473-2460
China - Qingdao
Tel: 86-532-8502-7355
China - Shanghai
Tel: 86-21-3326-8000
China - Shenyang
Tel: 86-24-2334-2829
China - Shenzhen
Tel: 86-755-8864-2200
China - Suzhou
Tel: 86-186-6233-1526
China - Wuhan
Tel: 86-27-5980-5300
China - Xian
Tel: 86-29-8833-7252
China - Xiamen
Tel: 86-592-2388138
China - Zhuhai
Tel: 86-756-3210040

India - Bangalore
Tel: 91-80-3090-4444
India - New Delhi
Tel: 91-11-4160-8631
India - Pune
Tel: 91-20-4121-0141
Japan - Osaka
Tel: 81-6-6152-7160
Japan - Tokyo
Tel: 81-3-6880- 3770
Korea - Daegu
Tel: 82-53-744-4301
Korea - Seoul
Tel: 82-2-554-7200
Malaysia - Kuala Lumpur
Tel: 60-3-7651-7906
Malaysia - Penang
Tel: 60-4-227-8870
Philippines - Manila
Tel: 63-2-634-9065
Singapore
Tel: 65-6334-8870
Taiwan - Hsin Chu
Tel: 886-3-577-8366
Taiwan - Kaohsiung
Tel: 886-7-213-7830
Taiwan - Taipei
Tel: 886-2-2508-8600
Thailand - Bangkok
Tel: 66-2-694-1351
Vietnam - Ho Chi Minh
Tel: 84-28-5448-2100

Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4485-5910
Fax: 45-4485-2829
Finland - Espoo
Tel: 358-9-4520-820
France - Paris
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Garching
Tel: 49-8931-9700
Germany - Haan
Tel: 49-2129-3766400
Germany - Heilbronn
Tel: 49-7131-72400
Germany - Karlsruhe
Tel: 49-721-625370
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Germany - Rosenheim
Tel: 49-8031-354-560
Israel - Ra’anana
Tel: 972-9-744-7705
Italy - Milan
Tel: 39-0331-742611
Fax: 39-0331-466781
Italy - Padova
Tel: 39-049-7625286
Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Norway - Trondheim
Tel: 47-72884388
Poland - Warsaw
Tel: 48-22-3325737
Romania - Bucharest
Tel: 40-21-407-87-50
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
Sweden - Gothenberg
Tel: 46-31-704-60-40
Sweden - Stockholm
Tel: 46-8-5090-4654
UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820

Worldwide Sales and Service
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